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KATA PENGANTAR 

 

Sejalan dengan upaya peningkatan kemampuan sumber daya manusia pada 

organisasi perangkat daerah urusan statistik, pembinaan terus dilakukan. Salah satu upaya 

pembinaan yang ditempuh adalah melalui penerbitan modul pembinaan teknis. 

Modul-modul tersebut merupakan satu kesatuan yang saling melengkapi. Kehadiran 

modul Statistik untuk para penyelenggara kegiatan statistik sektoral ini memiliki nilai 

strategis karena dapat menjadi acuan dalam proses pembagian pengetahuan (knowledge 

sharing). Modul ini dapat membantu fasilitator pembinaan penyelenggaraan statistik 

sektoral dalam mendisain pengajaran yang akan disampaikan kepada para peserta 

pembinaan. Selain itu, membantu pengelola dan penyelenggara dalam penyelenggaraan 

pembinaan serta membantu peserta dalam mengikuti proses pembinaan. 

Seiring dengan perkembangan lingkungan strategis yang berlangsung dengan cepat 

khususnya terhadap dinamika kompetensi aparatur sipil negara dalam tugasnya 

melaksanakan tugas-tugas perstatistikan, maka kualitas modul, khususnya kesesuaian isi 

dengan persyaratan kompetensi aparatur yang mengalami perkembangan, perlu terus 

dipantau dan dilakukan penyempurnaan. Oleh sebab itu, jika ditemukan hal-hal yang tidak 

relevan lagi atau dianggap perlu untuk menambahkan isi dari modul, maka akan dilakukan 

perbaikan. 

Modul ini merupakan bahan ajar minimal dalam pembinaan statistik sektoral. 

Walaupun demikian, fasilitator dapat mengembangkan selama masih relevan dengan hasil 

belajar yang akan dicapai dalam modul ini. 

Akhirnya, selamat menggunakan modul-modul pembinaan ini, dengan harapan 

kompetensi statistik peserta dapat ditingkatkan. 

 

Jakarta, Oktober 2019 
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BAB I  

PENDAHULUAN 

 

A. Latar Belakang 

Undang-undang No. 23 Tahun 2014 tentang Pemerintahan Daerah telah 

mengamanatkan bahwa terdapat pembagian urusan di tingkat pusat, provinsi, dan 

kabupaten/kota. Urusan tersebut merupakan urusan pemerintah konkuren yang terdiri dari 

urusan wajib dan urusan pilihan. Salah satu urusan wajib non-pelayanan dasar yang harus 

dilaksanakan oleh pemerintah daerah adalah urusan statistik. 

Sementara itu, Undang-undang No. 16 Tahun 1997 tentang Statistik, telah 

membedakan penyelenggaraan statistik menjadi tiga, yaitu statistik dasar, statistik sektoral, 

dan statistik khusus. Statistik dasar diselenggarakan oleh Badan Pusat Statistik (BPS), 

statistik sektoral oleh instansi pemerintah selain BPS, sedangkan statistik khusus 

diselenggarakan oleh masyarakat baik perorangan maupun lembaga/perusahaan. Dengan 

demikian, penyelenggaraan urusan statistik pada pemerintah daerah merupakan 

penyelenggaraan urusan statistik sektoral. 

Berdasarkan Peraturan Presiden no. 39 Tahun 2019 tentang Satu Data Indonesia, BPS 

tidak hanya menjadi penyelenggara statistik dasar, tetapi juga  sebagai  pembina statistik. 

Oleh sebab itu, BPS perlu menyiapkan sumber daya yang memadai untuk mendukung 

penyelenggaraan statistik sektoral. Salah satu yang dilakukan adalah melakukan 

peningkatan kemampuan sumber daya manusia pada penyelenggaraan statistik sektoral. 

Dalam kaitannya dengan penyelenggaraan kegiatan statistik sektoral oleh perangkat 

daerah, diperlukan pengetahuan bisnis proses penyelenggaraan statistik. Dalam hal ini, 

perlu disusun bahan-bahan ajar yang mudah dipahami dan dilaksanakan oleh penyelenggara 

urusan statistik di provinsi dan kabupaten/kota.  

Modul Process/Pengolahan ini sebagai salah satu bagian dari modul-modul lainnya 

mengenai proses bisnis penyelenggaraan kegiatan statistik yang dirancang untuk 

peningkatan kemampuan penyelenggara statistik sektoral, khususnya dalam 

Process/Pengolahan data dalam penyelenggaraan statistik. Modul ini mengantarkan para 

peserta untuk memahami cara-cara dalam tahapan Process/Pengolahan penyelenggaraan 
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statistik. Di samping itu, modul ini digunakan sebagai pedoman bagi fasilitator dalam 

mendesain praktikum atau penerapan dalam perencanaan kegiatan statistik.  

B. Deskripsi Singkat 

Modul pengolahan data ini merupakan pengantar untuk lebih memahami proses 

pengolahan dari data mentah menjadi informasi dengan cakupan materi pembelajaran yaitu 

Arti dan konsep pengolahan data, Pengolahan data secara manual, dan Pengolahan data 

dengan komputer. Pada bagian akhir modul telah dilengkapi suplemen yang diharapkan 

dapat memberikan pengetahuan yang bermanfaat bagi pembaca. 

Materi Paket Program Statistik membahas tentang pengolahan data statistik dengan 

menggunakan software Ms. Excel yang bertujuan untuk mempermudah interpretasi suatu 

informasi yang dijelaskan dengan perhitungan statistik. 

 

C. Hasil Belajar (Tujuan Pembelajaran) 

Setelah membaca modul ini peserta pelatihan dapat mengerti dan mampu 

melakukan proses pengolahan data, dengan menggunakan paket program Excel. 

 

D. Indikator Hasil Belajar 

Setelah mempelajari modul ini secara tuntas, peserta diharapkan dapat: 

a. Menjelaskan pengertian data dan informasi 

b. Memahami proses pengolahan data 

c. Melakukan pengolahan data dengan menggunakan Ms. Excel 

 

E. Materi Pokok 

Materi dan submateri pokok yang dibahas dalam modul ini adalah: 

1. Pengertian data dan informasi Persiapan data 

a. Pengertian data 

b. Pengertian statistik 

c. Pengertian informasi 

d. Kegunaan data dan Statistik 

2. Proses Pengolahan data 
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a. Melakukan Pengintegrasian data 

b. Melakukan klasifikasi 

c. Melakukan Pemeriksaan, Pengkodean, dan Penginputan 

 

3. Pengolahan data dengan Ms. Excel 

a. Entri data 

b. Validasi data 

c. Tabel 

d. Grafik 

e. Memeriksa duplikasi data 

f. Ukuran pemusatan data 

 

F. Manfaat 

Berbekal hasil belajar pada Modul Process/Pengolahan ini, peserta diharapkan 

mampu menerapkan dan mereplikasi tata cara pengolahan data pada unit kerja masing-

masing. Pada akhirnya, diharapkan juga dapat meningkatkan kinerja instansinya. 
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BAB II  

DATA, STATISTIK, DAN INFORMASI 

 

Sebelum pembahasan mengenai statistik secara lebih lanjut, perlu adanya 

pemahaman/pengertian terhadap data , informasi, dan statistik terlebih dahulu. Dalam 

penggunaan biasa istilah data dan informasi sering dipertukarkan, pada hal sesungguhnya 

secara konsep berbeda. Demikian juga data, statistik dan informasi sering dianggap sama 

saja. Untuk mendapatkan gambaran yang lebih pas berikut ini diberikan konsep/ pengertian 

dari istilah–istilah tersebut. 

 

A. Arti dan Pengertian Data 

Dalam kamus besar Bahasa Indonesia, data berarti sekumpulan keterangan yang 

benar atau nyata.  Keterangan tersebut bisa berupa angka, huruf, simbol ataupun gambar.  

Demikian juga dalam kamus wikipedia (http://id.wikipedia.org/wiki/Data), data disebutkan 

sebagai catatan atas kumpulan fakta. Data merupakan bentuk jamak dari datum, berasal 

dari bahasa Latin yang berarti "sesuatu yang diberikan". Dalam penggunaan sehari-hari data 

berarti suatu pernyataan yang diterima secara apa adanya. Dari sudut pandang bisnis, data 

bisnis adalah deskripsi organisasi tentang sesuatu (resources) dan kejadian (transactions) 

yang terjadi. Pengertian yang lain menyebutkan bahwa data adalah deskripsi dari suatu 

kejadian yang kita hadapi . 

Kata data bisa berarti juga fakta mentah dan tidak terukur, yang bila diolah akan 

menjadi suatu informasi. Atau dengan kata lain tujuan mendasar dari pengumpulan dan 

pengolahan data adalah untuk menghasilkan informasi. Meskipun data merupakan bahan 

utama informasi, namun perlu diingat tidak semua data relevan  dan tepat waktu untuk 

menghasilkan informasi. 

Contoh: 

a. Data umur peserta diklat statistik sektoral: 28, 30, 24, 25, 25, 26, 27, 28, 31, 31, 

24, 27, 29, 29, 30, 31, 28, 29, 25, 23, 26, 27, 25, 24, 23. 

b. Data nilai ujian komprehensif dari peserta diklat fungsional statistik terampil 

angkatan I: 89,  87, 90, 93, 94, 94, 95, 82, 80, 76, 80, 90, 100, 92, 90, 98, 80, 83, 

78, 77, 90, 96, 86, 87, 80. 
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B. Arti dan Pengertian Statistik 

Kata statistik sering menimbulkan bayangan akan angka dalam tabel atau grafik – 

grafik. Kata statistik berasal dari bahasa latin ”status” yang dalam bahasa inggris berarti 

”state” yang diartikan dalam bahasa indonesia sebagai ”pernyataan” (Johnson and 

Bhattacharya, 2007). Memang dalam pengertian awam statistik bersinonim dengan data, 

dimana dalam bahasa inggris disebut dengan statistic.  Statistik dalam hal ini juga biasa 

dikenal dengan informasi, karena telah melalui proses pengolahan, analisis dan penyajian 

yang tepat dan menjadi bermakna. 

Statistik juga berarti nama suatu ilmu, yaitu ilmu yang berkaitan dengan data, yang 

kalau dalam bahasa inggris dikenal dengan istilah statistics.  Dalam modul ini selanjutnya 

kata statistik diartikan sebagai produk kegiatan statistik, khususnya pengumpulan, 

pengolahan data, meringkas dan menginterpretasikan sampai pada pengambilan keputusan 

(Johnson and Bhattacharya, 2007). Apakah suatu statistik sudah berupa informasi?  

Jawabanya bisa subyektif, tergantung kebutuhan khusus pengguna sendiri, karena suatu 

tabel statistik mungkin sudah merupakan informasi bagi A tetapi belum bagi B (sebab masih 

perlu diolah lagi). 

Sedangkan yang dimaksud dengan data statistik adalah deskripsi numerik dari aspek 

kuantitatif sesuatu. Namun demikian tidak semua diskripsi numerik adalah data statistik, 

dikatakan data statistik jika mempunyai ciri-ciri sebagai berikut: 

a) Harus dalam bentuk agregat (seperti: jumlah, rata-rata, proporsi dan 

persentase). 

b) Perubahan karakteristik fenomena yang diteliti disebabkan oleh sejumlah 

kekuatan yang bekerja secara simultan. Contoh: perubahan yang terjadi pada 

tingkat penjualan, kualitas produk, jumlah penduduk, dsbnya. 

c) Diperoleh dengan cara pencacahan/pengukuran atau diestimasi berdasarkan 

standar akurasi yang memadai. 

d) Harus dikumpulkan secara sistematik bagi maksud/tujuan yang telah ditetapkan 

sebelumnya. 
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e) Fakta harus dapat dibandingkan, misalnya perbandingan antar waktu bagi fakta 

yang sama.  Fakta (data) yang sama diperoleh dengan cara dan pengukuran yang 

sama pula dan hanya waktu pelaksanaan pengukuran/pencacahan yang 

berbeda. Sebagai contoh: Jumlah impor beras Indonesia tahun 2013 

dibandingkan dengan data yang sama untuk tahun 2012. 

 

C. Arti dan Pengertian Informasi 

Informasi berbeda secara mendasar dengan data. Informasi adalah hasil agregasi 

atau pengolahan data yang akan meningkatkan pengetahuan dan wawasan pengguna 

informasi. Data dapat menjadi informasi setelah dilakukan pemilihan, pengurutan, analisis 

dan interpretasi yang tepat dan relevan dengan masalah yang dihadapi.Fungsi utama 

informasi (statistik) adalah memberikan penjelasan atau keterangan, mengurangi adanya 

banyak pilihan/alternatif dan meningkatkan kepastian. Suatu keputusan yang berlandaskan 

informasi akan lebih bijaksana. 

 

Contoh: 

Pusdiklat BPS baru saja menyelenggarakan diklat statistik sektoral.  Diklat diikuti 

oleh 25 peserta dengan umur yang relatif muda, yaitu rata-rata umur peserta diklat baru 

mencapai 27 tahun.  Hasil ujian komprehensif menunjukkan nilai rata-rata yang cukup bagus 

yaitu 87,48. Namun demikian ada 3 orang peserta yang dinyatakan lulus bersyarat karena 

memperoleh nilai komprehensif dibawah 80. 

 

D. Kegunaan Data dan Statistik 

Setelah memahami arti dan pengertian data dan statistik, tentunya perlu diperluas 

wawasan tentang manfaat dan kegunaannya sehingga dapat lebih dipahami tentang konsep 

dasar statistik sebagai bahan pembelajaran berikutnya. Guna memahami kegunaan data dan 

statistik, di dalam bagian ini akan diuraikan tentang jenis dan kegunaan data dan statistik 

secara singkat.  
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D.1. Jenis Data 

Seperti telah diuraikan sebelumnya, data merupakan sekumpulan angka, huruf atau 

simbol/gambar, Jenis-jenis data dapat dibagi berdasarkan sifatnya, sumbernya, cara 

memperolehnya, waktu pengumpulannya dan skala datanya sebagai berikut. 

a. Menurut sifatnya 

Berdasarkan sifatnya, data dapat dibedakan menjadi: 

• Data Kualitatif, yaitu data yang tidak berbentuk angka, misalnya: Kuesioner 

Pertanyaan tentang suasana kerja, kualitas pelayanan sebuah rumah sakit atau 

gaya kepemimpinan, dll. 

• Data Kuantitatif, data yang berbentuk angka, misalnya: harga saham, besarnya 

pendapatan, dll. 

 

b. Menurut waktu pengumpulannya 

Data dapat dikumpulkan pada beberapa waktu yang berbeda, maka data 

berdasarkan waktu pengumpulannya dapat dibedakan sebagai: 

• Data cross section, yaitu data yang dikumpulkan pada suatu waktu tertentu (at a 

point of time) untuk menggambarkan keadaan dan kegiatan pada waktu 

tersebut. Misalnya; data penelitian yang menggunakan kuesioner. 

• Data berkala (time series data), yaitu data yang dikumpulkan dari waktu ke 

waktu untuk melihat perkembangan suatu kejadian/ kegiatan selama periode 

tersebut. Misalnya, perkembangan uang beredar, harga 9 macam bahan pokok 

penduduk. 

 

c. Menurut cara memperolehnya 

Menurut cara memperolehnya, data terdiri dari: 

• Data Primer (primary data): data primer adalah data yang dikumpulkan sendiri 

oleh perorangan/suatu organisasi secara langsung dari objek yang diteliti dan 

untuk kepentingan studi yang bersangkutan yang dapat berupa interview, 

observasi. 
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• Data Sekunder (secondary data): data sekunder adalah data yang diperoleh/ 

dikumpulkan dan disatukan oleh studi-studi sebelumnya atau yang diterbitkan 

oleh berbagai instansi lain. Biasanya sumber tidak langsung berupa data 

dokumentasi dan arsip-arsip resmi. 

 

d. Menurut sumbernya data 

Bila dilihat dari sudut pandang suatu organisasi, menurut sumbernya data dibedakan 

menjadi (Supranto, 1990) 

• Data Internal: data intenal adalah data dari dalam suatu organisasi yang 

menggambarkan keadaan organisasi tersebut. Contohnya: suatu perusahaan, 

jumlah karyawannya, jumlah modalnya, atau jumlah produksinya, dll. 

• Data Eksternal: data eksternal adalah data dari luar suatu organisasi yang dapat 

menggambarkan faktor-faktor yang mungkin mempengaruhi hasil kerja suatu 

organisasi. Misalnya: daya beli masyarakat mempengaruhi hasil penjualan suatu 

perusahaan. 

 

e. Menurut skala data 

Bila dilihat dari skala data, maka jenis-jenis data dapat terbagi antara lain:  

• Data Nominal: data yang diperoleh dengan cara katagorisasi atau klasifikasi. 

Data Nominal tidak dapat dilakukan operasi matamatika (X, +, - atau : ). 

Misalnya, jenis pekerjaan diklasifikasikan dalam pegawai negeri (kode 1) , 

pegawai swsta (kode 2 ) dan wiraswata (kode 3). Dari contoh itu, tidak mungkin 

3-2=1 (wiraswasta –pegawai negeri = pegewai swasta).  

• Data Ordinal: data yang diperoleh dengan cara katagorissi atau klasifikasi, tetapi 

diantara data tersebut terdapat hubungan. Data Ordinal juga tidak bisa 

dilakukan operasi matamatika. 

Misalnya, kepuasan pelanggan, diklasifikasikan sebagai: sangat puas (diberi 

tanda 1), Puas (diberi tanda 2), Cukup puas (diberi tanda 3), Tidak puas(diberi 

tanda 4), dan Sangat tidak puas (diberi tanda 5). Posisi 1 lebih tinggi dibanding 
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posisi 2, Tidak mungkin 1+2=3 (yang berarti sangat puas ditambah puas = cukup 

puas 

• Data Interval: data yang diperoleh dengan cara pengukuran, dimana jarak antar 

dua titik pada skala, sudah diketahui. Berbeda dengan skala ordinal, dimana 

jarak dua titik tidak diperhatikan (seperti berapa jarak antara puas dan tidak 

puas, yang sebenarnya menyangkut perasaan orang saja) 

Misalnya, temperatur ruangan. Bisa diukur dalam Celsius, atau Fahrenheit, 

dengan masing-masing punya skala sendiri. Untuk air membeku dan mendidih: 

Celcius pada 0° C sampai 100° C. Sakala ini jelas jaraknya, bahwa 100-0=100.  

Fahreinheit pada 32° F sampai 212°F. Skala ini jelas jaraknya, 212-32=180 

• Data Rasio: adalah data yang diperoleh dengan cara pengukuran, dimana jarak 

dua titik pada skala sudah diketahui, dan mempunyai titik nol yang absolut. Ini 

berbeda dengan skala interval, dimana tak ada titik nol mutlak/absolut. Seperti 

titik 0°C tentu beda dengan titik 0°F. atau pergantian tahun pada system 

kalender Masehi (setiap 1 Januari) berbeda dengan pergantian tahun Jawa, 

China dan lainnya. Sehingga tak ada tahun baru dalam artian diakui oleh semua 

kalender sebagai tahun baru. 

Misalnya, jumlah buku di kelas: Jika 5, berarti ada 5 buku. Jika 0, berarti taka da 

buku (absolut 0). Tidak ada kategorisasi atau pemberian kode. Bisa dilakukan 

operasi matematika. Missal: 100 cm + 35 cm = 135 cm; 5 mangga + 2 mangga = 7 

mangga. 

 

D.2. Kegunaan Statistik di Berbagai Sektor 

Dalam perkembangan ilmu pengetahuan dan teknologi informasi, statistik banyak 

diterapkan dalam berbagai sektor, baik di sektor bisnis, ekonomi, pertanian, industri, 

maupun sosial, politik dan pertahanan/keamanan. Di sektor pemerintahan misalnya, 

statistik digunakan sebagai alat pengambil keputusan dalam rangka macam tujuan 

pembangunan, diantaranya adalah untuk mengetahui jumlah dan karakteristik penduduk 

yang dilakukan melalui kegiatan sensus penduduk.  
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Dari kegiatan statistik ini dapat diperoleh beberapa gambaran penduduk 

diantaranya: jumlah penduduk, tingkat pendidikan, penyebaran penduduk, ketenagakerjaan 

dan karakteristik sosial budaya lainnya. Perkembangan harga (dalam bidang ekonomi) juga 

dapat diketahui dengan data statistik yang dikumpulkan secara sampel melalui survei, yaitu 

Survei Harga Konsumen yang dilakukan secara harian, mingguan dan bulanan sehingga 

dapat menghasilkan angka inflasi. 

Dalam rangka mendukung pembangunan nasional dan wilayah, maka statistik daerah 

sangat diperlukan sebagai bahan penyusunan perencanaan daerah dan nasional, sebagai 

bahan pemantauan pelaksanaan pembangunan, dan selanjutnya sebagai bahan evaluasi 

hasil pembangunan. Ada kata pepatah membangun itu sulit, tapi lebih sulit lagi membangun 

tanpa data, karena suatu perencanaan dan kebijakan tidak akan bermanfaat dan tepat 

sasaran kalau tidak didukung dengan adanya data yang akurat. 

Dengan perkembangan ekonomi nasional dan global saat ini, data dan statistik juga 

dirasakan semakin penting peranannya dalam pembangunan sektor ekonomi. Sebagai 

contoh dengan berkembangnya bisnis asuransi dan valuta asing, maka teori probabilitas 

(hitung peluang) menjadi dasar pemikiran para pelaku usaha di bidang ini. Dalam sektor 

industri dan perdagangan, data statistik tentang besarnya kepemilikan modal dan asset 

perusahaan, penggunaan faktor produksi, hasil produksi dan pemasaran merupakan faktor 

penting untuk ditelaah demi kemajuan perkembangan bisnis atau indutri dan perdagangan 

yang lebih luas lagi. 

Soetjipto (2007) mengatakan bahwa ada empat alasan mengapa statistik itu 

penting dalam dunia bisnis, yaitu pertama karena statistik digunakan sebagai catatan 

kegiatan usaha dan keterangan lain yang berkaitan dengan kegiatan usahanya; kedua 

karena data statistik merupakan bagian penting dalam laporan bisnis/usahanya; ketiga 

karena statistik sebagai alat kontrol yang memberikan informasi kuantitatif bagi direksi 

dalam melakukan pengendalian operasional usaha/bisnis; dan keempat karena statistik 

sebagai dasar pengambilan keputusan yang telah memperhitungkan faktor resiko. Untuk 

pengembangan bisnis biasanya dilakukan dahulu survei pasar untuk menggali infromasi 

tentang pangsa pasarnya, siapa target pembelinya, seberapa besarnya, kapan dan dimana 

cocok dipasarkannya. Survei yang dilakukan tentunya harus mengikuti prosedur yang benar 
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bersarkan tehnik pengumpulan data yang tepat, diolah dengan cara yang tepat dan benar 

serta dianalisis sesuai kebutuhan dengan menggunakan kaidah-kaidah statistik yang ada. 

Penerapan ilmu statistik lainnya yang sekarang popular adalah prosedur jajak 

pendapat atau pooling (misalnya dilakukan sebelum pemilihan umum). Sudah sering kita 

dengar dan baca dalam pelaksanaan pemilihan kepala daerah, sering ada pooling tentang 

prediksi hasil pilkada, atau bahkan untuk melihat hasilnya secara cepat dilakukan 

perhitungan cepat hasil pemilu atau quick count dari para calon kepala daerah. 

Dengan dasar perhitungan angka-angka indeks dapat dikembangkan berbagai 

indikator baru yang sedang aktual saat ini seperti Indeks Kualitas Hidup Manusia, Indeks 

Pembangunan Manusia, Indeks Pemberdayaan Gender, Indeks Kebahagiaan, Indeks 

Demokrasi Indonesia dan lain-lainnya. Semua indikator tersebut dapat memberikan 

gambaran perkembangan keadaan ekonomi, sosial dan politik antar wilayah maupun antar 

waktu. 

Dengan berbagai jenis data tersebut diatas, tentunya banyak sekali kegunaan dari 

data yang telah dikumpulkan, karena dengan data dapat diperoleh gambaran tentang suatu 

keadaan yang sedang menjadi perhatian. Secara rinci kegunaan data adalah sebagai berikut: 

i. Sebagai dasar untuk penyusunan perencanaan kegiatan. 

ii. Perencanaan yang baik dan tepat harus didasari dengan data yang akurat, 

karena bila data yang digunakan sebagai dasar perencanaan tidak 

menggambarkan keadaan yang sebenarnya maka perencanaannya juga 

menjadi tidak tepat. 

iii. Sebagai dasar pembuatan keputusan dalam memecahkan masalah. 

iv. Setiap masalah tentu ada penyebabnya, untuk melihat penyebab terjadinya 

masalah maka dapat diidentifikasi faktor-faktornya melalui data-data yang 

berhubungan dengan permasalahan yang sedang diperhatikan. 

v. Sebagai alat kontrol/pengendalian dalam pelaksanaan suatu kegiatan yang 

telah direncanakan. 

vi. Dengan adanya data yang berupa pemantauan pelaksanaan suatu kegiatan, 

maka dapat diketahui sejauh mana pelaksanaan sesuai dengan perencanaan 

yang telah disusun. 
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vii. Sebagai bahan evaluasi hasil suatu kegiatan. 

viii. Setelah kegiatan selesai dilaksanakan, maka diperlukan data yang dapat 

menggambarkan sejauh mana pelaksanaan kegiatan itu telah berhasil 

dilaksanakan atau gagal dalam mencapai tujuannya. 

 

E. Syarat data dan data statistik yang baik 

Dalam memanfaatkan data dan statistik dalam berbagai sektor, maka data dan 

statistik yang dapat digunakan adalah data dan statistik yang memiliki kualitas yang baik, 

dalam hal menilai apakah kualitas data dan statistik baik atau tidak, maka faktor-faktor yang 

dapat menjadi penilaian adalah sebagai berikut: 

a. Objektif 

Data yang objektif berarti bahwa data harus sesuai dengan keadaan yang 

sebenarnya (as it is). Contoh data yang tidak objektif adalah Rp.5.000,- yang dikatakan 

dengan harganya Rp.7.500,- karena dalam kuitansi tertulis Rp.7.500,- tersebut adalah data 

yang tidak objektif. 

b. Representatif (mewakili) 

Data statistik harus mewaki kelompok objek yang di amati. Misalnya data rata-rata 

produksi padi di daerah A yang hanya diwakili oleh rata-rata produksi dari sawah yang subur 

saja. Data ini tidak mewakili rata-rata (atau gambaran umum) produksi padi di daerah A 

yang sesungguhnya. 

c. Bergalat (error) kecil 

Suatu data yang baik bila mempunyai tingkat kesalahan yang kecil, yaitu beda yang 

kecil dari nilai yang sesungguhnya (true value). Kesalahan tersebut berupa kesalahan 

sampling (sampling error) (bila data tersebut berdasarkan pengamatan sebagian sampel) 

atau kesalahan bukan sampling (non-sampling error) (yang dapat terjadi baik data 

berdasarkan sampel atau berdasarkan pengamatan keseluruhan). 

d. Tepat waktu (Timeliness). 

Apabila data akan dipergunakan untuk melakukan perencanaan, pengendalian atau 

evaluasi, maka syarat data yang tepat waktu ini penting sekali agar bisa bermanfaat, 

misalnya dalam pengendalian kegiatan maka sempat dilakukan penyesuaian dalam 



Diklat Statistik Sektoral 

 

 

 

Modul Process / Pengolahan   13 

 

pelaksanaan kegiatan kalau ada kesalahan atau penyimpangan di dalam implementasi. Data 

yang tersedia tetapi tidak pada saat diperlukan tentunya kurang bermanfaat. 

e. Relevan. 

Data yang dikumpulkan harus ada hubungannya dengan masalah yang akan 

diselesaikan. Misal, pemerintah ingin menanggulangi korban banjir di suatu daerah maka 

yang perlu dicatat adalah data dari mereka yang terkena korban banjir di daerah tersebut, 

bukan data dari penduduk lain.  

f. Reliabel. 

Data yang reliabel adalah data yang dapat diandalkan, yaitu data yang berkualitas 

yang dikumpulkan dan diolah dan disajikan mengikuti kaidah-kaidah statistik. 

 

F. Pengertian Variabel 

Sebuah variabel (peubah) adalah sebuah karakteristik, angka, atau kuantitas dari 

unit pengamatan yang dapat diukur atau dihitung. Sebuah variabel dapat juga disebut 

sebagai sebuah butir data (data item). Disebut variabel atau peubah karena nilainya dapat 

bervariasi antar unit pengamatan atau berubah-ubah dari suatu unit pengamatan ke unit 

pengamatan lain, dan juga dapat berubah antar waktu. Umur, berat, tinggi, pendapatan, 

tempat lahir, pandangan terhadap program pemerintah, misalnya, merupakan contoh 

variabel yang umum ditemui dalam kehidupan sehari-hari.  

Jelas bahwa variabel ini nilainya bisa berbeda-beda antar unit pengamatan dan juga 

bisa berubah antar waktu. Suatu unit pengamatan, misal individu, bisa diukur satu 

variabelnya saja, misal umur, atau bisa dihitung banyaknya teman yang dimiliki. Jadi ada 

variabel yang nilainya bisa diperoleh berdasarkan pengukuran (measurement) dan ada pula 

yang bisa diperoleh melalui penghitungan (counting). Jenis-Jenis variabel, dapat diuraikan 

sebagai berikut: 

a. Variabel Kontinu 

Variabel yang memiliki nilai sembarang, baik berupa nilai bulat maupun pecahan, 

diantara dua nilai tertentu atau variabel yang mengambil seluruh nilai dalam suatu interval. 

Contoh: berat badan, tinggi, luas, pendapatan, dsb. Berat badan dapat ditulis 45 kg; 

15 kg; atau 52,125 kg. 
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b. Variabel Diskrit 

Konsep yang nilainya tidak dapat dinyatakan dalam bentuk pecahan atau desimal di 

belakang koma. Variabel Diskrit ini sering juga disebut sebagai variabel kategori. Bila dalam 

satu variabel tersebut mempunyai dua kategori saja maka variabel tersebut dinamakan 

variabel dikhotom. 

Contoh dikhotom seperti: Jenis kelamin Laki-laki, Perempuan;Status perkawinan Kawin, 

tidak kawin. Adapun contoh Politom yaitu Tingkat pendidikan SD, SMP, SMA, PT Jumlah 

Anak 1, 2, 3, 4. 

c. Variabel Dependen dan Independen 

Variabel independen (independent variable) adalah tipe variabel yang menjelaskan atau 

mempengaruhi variabel yang lain. Variabel dependen (dependent variable) adalah tipe 

variabel yang dijelaskan atau dipengaruhi oleh variabel independen. Kedua tipe variabel ini 

merupakan kategori variabel penelitian yang paling sering digunakan dalam penelitian 

karena mempunyai kemampuan aplikasi yang luas. 

Contoh, ada hubungan antara konsumsi dan pendapatan, di mana dengan bertambahnya 

pendapatan, konsumsi juga akan bertambah, maka Konsumsi merupakan variabel dependen 

(terikat dengan pendapatan), sedanglan Pendapatan adalah variabel independen (variabel 

bebas) 

d. Variabel Moderator dan Random 

Variabel moderator merupakan variabel yang mempengaruhi (memperkuat dan 

memperlemah) hubungan antara variabel bebas dan variabel terikat. Variabel Moderator 

disebut juga variabel independen kedua. Sedangkan untuk menggambarkan hasil-hasil 

percobaan sebagai nilai-nilai numerik secara sederhana kita menggunakan apa yang disebut 

sebagai variabel acak/variabel random. Jadi variabel acak dapat didefinisikan sebagai 

deskripsi numerik dari hasil percobaan. 

Contoh, variabel yang mempengaruhi kebutuhan(demand) terhadap ikan (Y) adalah harga 

ikan (X1), pendapatan (X2), dan harga daging (X3). Ketiga variabel tersebut adalah variabel 

utama. Jika umur (X4) juga berpengaruh, tetapi bukanlah sebagai penyebab utama, maka 

umur (X4) ini lah yang disebut dengan variabel moderator. Disamping variabel tertentu yang 

nyata mempengaruhi variabel dependen, masih terdapat variabel lain yang tidak 
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dimasukkan dalam persamaan hubungan di atas. Variabel ini dinamakan variabel random, 

dan pengaruhnya dapat dilihat berdasarkan error yang timbul dalam mengadakan estimasi. 

e. Variabel Aktif 

variabel bebas yang dimanipulasikan oleh peneliti. Contoh variabel ini adalah, jika peneliti 

memanipulasikan metode mengajar, cara menghukum mahasiswa, maka metode mangajar 

dan cara menghukum, adalah variabel aktif, karena variabel ini dapat dimanipulasikan 

f. Variabel Atribut 

Variabel yang tidak dapat atau sukar untuk dimanipulasi. Variabel atribut umumnya 

merupakan karakteristik manusia seperti intelegensia, jenis kelamin, status sosial, 

pendidikan, sikap, dan sebagainya. 
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BAB III  

PROSES PENGOLAHAN DATA 

 

Tahapan proses atau pengolahan data menentukan seberapa jauh tingkat akurasi 

dan ketepatan data statistik yang dihasilkan. Tahap ini mendeskripsikan persiapan data 

sebelum data tersebut dianalisis dan didiseminasikan sebagai output. Pada tahap ini, data 

yang digunakan merupakan data final hasil pengumpulan data. 

A. Melakukan Integrasi Data 

Integrasi data adalah aktivitas yang bertujuan menggabungkan data yang berasal 

dari dua atau lebih sumber data. Dengan kata lain, data hasil pengumpulan data yang 

disimpan secara terpisah akan digabungkan sebelum diolah lebih lanjut. Data dalam hal ini 

bisa berupa dokumen hasil pencacahan atau dalam bentuk lain sesuai dengan tools yang 

digunakan dalam pengumpulan data. Data yang digabungkan dapat berasal dari sumber 

internal dan eksternal.  

Data internal adalah data yang diperoleh dari dalam organisasi penyelenggara 

kegiatan statistik, sedangkan data eksternal adalah data yang diperoleh dari luar organisasi 

penyelenggara kegiatan statistik. 

Data yang telah diintegrasikan lalu dicatat dalam suatu daftar penerimaan data 

oleh unit kerja yang melaksanakan penerimaan data. Kegiatan penerimaan data meliputi:  

1. Menerima data dari petugas lapangan/pengumpul data; 

2. Memeriksa kelengkapan jumlah data;  

3. Membuat laporan perkembangan penerimaan data.Cakupan Jenis Data 

B. Melakukan klasifikasi  

Pengklasifikasian atau pengelompokkan dokumen (batching) merupakan proses 

pengelompokan dokumen hasil pengolahan. Pengelompokan dapat dilakukan menurut jenis 

dokumen dan wilayah, misalnya dokumen dikelompokkan menurut desa atau kecamatan. 

Dokumen yang telah dikelompokkan lalu disimpan dengan menyusun dokumen pada 

tempat penyimpanan dan pengelolaan dokumen agar mudah diambil apabila diperlukan 

pada tahapan pemeriksaan, pengkodean, dan penginputan data serta mudah pula 

dikembalikan ke tempat penyimpanan semula. 
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Kegiatan penyimpanan dokumen meliputi:  

• Menyusun dokumen pada tempat penyimpanan sehingga dokumen mudah 

dicari; 

• Menyiapkan dan memberikan dokumen kepada petugas editing/coding dan 

petugas data entry; 

• Menerima dan menyimpan kembali dokumen dari petugas editing/coding 

dan petugas data entry. 

 

C. Melakukan Pemeriksaan, Pengkodean, dan Penginputan  

Editing merupakan proses pemeriksaan pada isian dokumen hasil pencacahan 

dengan memperhatikan kaidah-kaidah editing yang telah ditetapkan. Hasil editing sangat 

mempengaruhi kualitas data dan proses pengolahan selanjutnya. 

Berbagai informasi yang sekiranya meragukan seharusnya sudah dapat dideteksi 

sejak dilakukan editing sehingga akan memperlancar kegiatan pengolahan selanjutnya. 

Proses editing meliputi pemeriksaan: 

1. Kelengkapan pengisian  

Dokumen hasil wawancara harus terisi lengkap sesuai daftar pertanyaan yang ada. 

Setiap pertanyaan yang diajukan harus mempunyai jawaban, sekalipun jawaban itu 

berbunyi “TIDAK TAHU” atau “TIDAK ADA PENDAPAT” atau “”TIDAK MENJAWAB”. Apabila 

terdapat jawaban yang kosong, kemungkinan pewawancara lupa menanyakan pertanyaan 

tersebut atau lupa menulis jawabannya. Jawaban yang kosong akan menimbulkan 

kebingungan dalam pengkodean (coding).  

Ketidaklengkapan isian akan menyebabkan kurangnya informasi yang dibutuhkan. 

Oleh karena itu tahap awal pada pemeriksaan dokumen adalah memeriksa kelengkapan 

isian, sehingga pertanyaan yang belum terisi dapat dilengkapi oleh pengumpul data, jika 

memungkinkan dilakukan kunjungan ulang ke sumber data. 

2. Kejelasan isian (dapat dibaca) 

Kejelasan isian dokumen juga harus diperhatikan, baik isian yang berbentuk tulisan 

maupun yang berbentuk angka. Ketidakjelasan tulisan maupun angka dapat menyebabkan 

kesalahan informasi yang diperoleh.  Tulisan yang buruk atau acak-acakan atau sukar dibaca 
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dapat mempersulit pengolahan data.  Kejelasan isian termasuk juga kejelasan makna 

jawaban. Pewawancara perlu menuliskan jawaban dengan pola kalimat yang lengkap, jelas, 

logis, serta sistematis mengikuti pola subjek, predikat, obyek, dan keterangan. 

3. Kesalahan isian 

Kesalahan isian merupakan hal yang harus dihindari seperti dalam kesalahan kode 

(laki-laki berkode 1, namun ditulis kode 2 yang merupakan kode untuk perempuan). Selain 

itu, data harus dicatat dalam satuan-satuan sesuai yang diinginkan dalam kuesioner.  

Kesalahan satuan akan mengakibatkan kesalahan data yang dihasilkan termasuk kesalahan 

dalam analisis data. Sebagai contoh apabila data mengenai luas tanah ditetapkan untuk 

diukur dalam satuan hektar; 

maka jangan sampai pada kuesioner ditulis lagi dalam satuan ukuran lain 

(meterpersegi, kubik, atau lainnya). 

4. Konsistensi isian dan relevansi jawaban 

Konsistensi isian merupakan kondisi isian dokumen sesuai pertanyaan yang terkait 

satu dengan lainnya. Petugas harus memeriksa apakah isian jawaban suatu pertanyaan 

konsisten dengan isian jawaban pertanyaan lain.  Ini juga harus diperhatikan. Apakah 

jawaban-jawaban responden yang dicatat pewawancara cukup logis dan sesuai antara 

jawaban di pertanyaan yang satu dengan jawaban lain di pertanyaan yang lain. 

Penyebabnya mungkin saja responden berusaha menutup-nutupi sesuatu atau 

boleh jadi pewawancara kurang kritis, kurang teliti mencatat jawaban atau bahkan malas 

untuk menanyakan lebih lanjut. Jawaban responden yang ada pada dokumen sering kali 

tidak atau kurang berkaitan dengan persoalan sebenarnya. Hal ini dapat terjadi apabila 

pewawancara kurang cakap merumuskan pertanyaan yang diajukan. 

5. Kewajaran isian 

Kewajaran isian juga harus diperiksa walaupun isian yang kurang wajar belum dapat 

dipastikan data tersebut salah. Pemeriksaan kewajaran ini dilakukan sebagai informasi awal 

bahwa isian ini harus dikonfirmasi kebenarannya. Biasanya peneliti membuat suatu batasan 

kewajaran data dengan membuat suatu range nilai setiap variabel.  Namun demikian ada 

kalanya pada suatu wilayah tertentu dapat terjadi diluar range tersebut.  Misalnya harga 
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suatu barang berkisar 5000 – 9000 per unit, tetapi di suatu wilayah dapat terjadi harga 

diatas 9000 yang disebabkan karena barang di wilayah tersebut langka. 

Petugas editing perlu teliti dalam memeriksa kelengkapan, kewajaran, dan 

konsistensi antar rincian satu dengan rincian yang lainnya. Jika menemui kejanggalan isian, 

dapat melaporkan ke pengawas editing agar dapat diambil tindakan seperlunya atau 

mengembalikan dokumen tersebut ke petugas lapangan agar diperbaiki.  

Setelah proses editing, maka tahap berikutnya adalah penyandian dokumen 

Penyandian  (coding) merupakan kegiatan mengubah data berbentuk huruf menjadi data 

berbentuk angka/bilangan.  Pengkodean data dilakukan untuk memberikan kode yang 

spesifik pada respon jawaban responden untuk memudahkan proses pencatatan data.  

Misalnya untuk variabel pekerjaan dilakukan coding 1 = Pegawai Negeri, 2 = Wiraswasta, 3 = 

Pegawai Swasta dan 4 = Pensiunan.  Jenis kelamin: 1 = Pria dan 2 = Wanita, dan sebagainya. 

Kegunaan dari coding adalah untuk mempercepat pada saat input data dan mempermudah 

pada saat analisis data.  Setelah proses pemeriksaan dan pengkodean data secara individu 

untuk setiap dokumen dilakukan, maka tahap selanjutnya adalah memasukan data ke 

aplikasi input data yang telah dibangun pada tahap implementasi dan telah sesuai dengan 

kaidah validasi instrumen pengumpulan data. Dalam melakukan input data, sebaiknya 

dibentuk koordinator dan petugas/operator kegiatan input data. Ketersediaan komputer PC 

menjadi dasar penetapan jumlah operator input data. 

D. Pengolahan data dengan Ms. Excel 

D.1. Entri Data 

Pada Microsoft Excel kita bisa membuat aplikasi sederhana untuk entri data dalam bentuk 

form. Dengan format form tampilan akan lebih menarik karena hanya muncul satu kolom yang 

awalnya berasal dari beberapa kolom. 

Langkah detailnya :Sebelum membuat form, tampilkan dahulu icon form lewat Customize 

Quick Access Toolbar. 
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Langkah selanjutnya, buat field-field data apa saja yang kita butuhkan.  

 

Kemudian blok sel range tersebut dan klik icon form. Dan hasilnya seperti gambar di bawah 

ini. 

 

Dari form yang sudah dibuat maka kita akan lebih mudah saat melakukan proses entri data. 

 

D.2. Validasi Data di Excel 

Salah satu fitur yang sering digunakan dalam penyajian laporan adalah validasi data. 

Validasi data dapat diterapkan untuk semua tipe data yang diolah Excel. Kita dapat menerapkan 

aturan-aturan tertentu sesuai kebutuhan untuk memberlakukan validasi data. 
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Untuk mengaktifkan validasi data dapat menggunakan menu Data>Data Validation.  

Langkah Detailnya : 

Blok sel-sel yang akan diterapkan validasi data. Pada menu Data Tools, klik Data Validation.  

 

Pada tab Settings pilih Whole Number, isi batas nilai yang dikehendaki pada kolom 

minimum dan maksimum.  

 

Kemudian klik di tab Error Alert, isikan pesan jika terjadi tidak valid data dan akhiri dengan 

menekan tombol OK. 
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Untuk mencoba validasi data yang diterapkan, isi misalkan dengan nilai negatif  kemudian 

tekan Enter.  

 

Pesan bahwa nilai yang dimasukkan tidak valid akan muncul. Tekan tombol Retry untuk 

merubah nilai yang valid. 

 

D.3. Tabel 

a. Jenis Tabel 

Membuat tabel, membuat garis pembatas/bingkai, sebenarnya kita telah belajar membuat 

tabel, tapi pada bagian ini kita akan membuat tabel dengan memanfaatkan fasilitas yang telah 

disediakan oleh Excel yang dikenal dengan Autoformat. Dengan fasilitas ini, Excel telah menyediakan 
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berbagai macam format tabel, kita tinggal memilih dan memanfaatkannya saja. Berikut cara 

menggunakan fasilitas ini :  

Blok range data yang akan dibuat tabelnya. Pilih menu Format As Table.  

 

Klik salah satu model tabel yang diinginkan.  

 

Klik OK untuk menutup jendela ini. Maka range yang disorot tadi akan diubah sesuai 

dengan tabel yang anda pilih. 
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b.  Pivot Tabel 

Pivot Table adalah sebuah tabel interaktif yang dalam waktu singkat mampu menampilkan 

ringkasan data dalam jumlah yang besar. Pivot Table bukan hanya memutar sumbu tabel, tetapi 

mampu melakukan kalkulasi setiap item yang dibutuhkan menggunakan cara dan perhitungan sesuai 

pilihan kita. 

Untuk mengaktifkan pivot tabel dapat menggunakan menu Insert>Pivot Tabel.  

 

Langkah-langkah menggunakan fasilitas ini :  

Blok range data yang akan dibuat tabel pivotnya. Pilih menu Insert > Pivot Table > 

PivotTable. Kemudian pilih hasil tabel pivot akan ditempatkan. 
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Kemudian pilih field yang akan ditempatkan pada Columns Labels, Row Labels dan Values.  

 

Hasil pengaturan dari pivot tabel di atas adalah sebagai berikut: 
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D.4. Grafik 

Grafik merupakan bentuk penyajian lain dari data sehingga akan mudah dimengerti ketika 

seseorang menganalisa suatu data. Selain dalam bentuk tabel, laporan juga dapat disajikan dalam 

bentuk grafik. Grafik pada Excel dapat disajikan dalam banyak bentuk dengan sudut elevasi dan 

perputaran yang kita dapat atur sesuai kebutuhan. Disamping itu, langkah-langkah di dalam 

pembuatan grafik sudah disediakan Excel dalam 4 langkah Wizard. Cara mengaktifkannya wizard 

tersebut adalah klik icon Chart atau klik menu Insert – Chart. 

a.  Jenis Grafik 

Salah satu fungsi unggul dalam Microsoft Excel adalah kita dapat melihat hasil tabel diubah 

menjadi ke dalam grafik dengan cepat. Microsoft Excel menyediakan berbagai macam bentuk grafik 

yang mencakupi Line, XY, Column, Bar, Batang, Area, Stock, dan sebagainya. Grafik dapat dilihat 

dalam menu INSERT sebagai berikut. 

 

Setelah klik tombol  , maka akan muncul menu sebagai berikut : 

 

Setelah masuk ke Insert Chart, maka silakan pilih jenis grafik yang anda inginkan sesuai 

selera anda. Jika sudah terpilih jenis Chart yang anda inginkan, silakan klik OK. Namun, karena 
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membuat grafik perlu sebuah tabel data untuk menampilkan grafiknya. Sehingga, silakan ikuti 

latihan berikut ini. 

Latihan 1 

Ketiklah tabel dibawah ini dalam worksheet baru anda! Simpan dengan nama file 

latihan.xls. 

 

 

Contoh Hasil a). adalah sbb : 

 

Latihan 2 

Ketiklah tabel berikut dan simpan dengan nama Anda. 
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Gambar. Grafik Dari Data Tabel 

 

b.  Pivot Grafik 

Microsoft excel menyediakan fasilitas untuk membuat grafik pada form dengan Pivot 

Chart. Sebelum membuat grafik kita harus membuat table sebagai data source grafik, Langkah 

detailnya sebagai berikut: 

Blok range data yang akan dibuat grafik pivotnya. Pilih menu Insert > PivotTable > 

PivotChart. Kemudian pilih hasil grafik pivot akan ditempatkan. 

 

Kemudian pilih field yang akan ditempatkan pada Legends Fields (Series), Axis Fields 

(Categories)  dan Values.  
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Hasil pengaturan dari grafik pivot di atas adalah sebagai berikut: 

 

 

Kita bisa mengubah type grafik dengan klik bagian grafik yang mau diformat kemudian klik 

Change Chart Type pada PivotChart Tools tab Design. 



Diklat Statistik Sektoral 

 

 

 

Modul Process / Pengolahan   30 

 

 

 

Untuk mengatur layout untuk setiap bagian grafik misalnya Title, Categori Axis, atau plot 

area, klik bagian grafik yang mau diformat, kemudian pada PivotChart Tools tab Layout. Akan muncul 

dialog untuk mengatur bagian yang terpilih. 

 

Hasil akhir untuk grafik seperti di bawah: 

 

 

D.5. Memeriksa Duplikasi Input Data 

Dalam menginput data, tidak jarang terjadi duplikat entri. Dengan adanya duplikat entri 

akan mengakibatkan hasil analisis menjadi tidak baik, sehingga pengolah data harus 

mengindentifikasi adanya dulpikat entri. Berikut ini cara untuk mengindentifikasi adanya duplikat 

entri. 

Pilih kolom yang akan diidentifikasi. 

Pada menu Home, klik Conditional Formating  -> Highligt Cell Rules  -> Duplicate Values  
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Pada penjelasan diatas, hanya akan menampilkan data-data yang terjadi duplikat dengan 

diberikan highlight tetapi tidak menghapus data yang duplikat. Dalam proses analisis data, perlu 

untuk tidak menyertakan data yang duplikat, sehingga data yang duplikat harus dihapus. Berikut ini 

cara untuk menghapus data yang duplikat. 

• Klik Filter Advanced pada menu Data 

• Pilih kolom yang akan diperiksa duplikat entrinya pada isian List range dan centang 

Unique records only 

• Setelah itu klik tombol OK,  
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D.6. Ukuran Pemusatan Data 

Terdapat beberapa ukuran dalam analisis ukuran pemusatan data. Pada modul ini hanya 

akan dibahas ukuran rata-rata, modus, dan median yang dapat dihitung dengan cara sebagai berikut. 

a. Rata-rata 

Pilih sel yang kosong, ketikkan =AVERAGE(). 
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Didalam tanda kurung diisikan kolom yang akan dihitung rata-ratanya. 

b. Modus 

Pilih sel yang kosong, ketikkan =MODE(). 

Didalam tanda kurung diisikan kolom yang akan dihitung modusnya. 

C. Median 

Pilih sel yang kosong, ketikkan =MEDIAN(). 

Didalam tanda kurung diisikan kolom yang akan dihitung mediannya. 

 



 

Diklat Statistik Sektoral 

 

Modul Process / Pengolahan 

 

 

Penyusun 

Budi Subandriyo, S.ST., M.Stat 

Eko Yulian, S.Si., M.Stat 

 

 

Edisi Pertama 

Oktober, 2019 

 

 

 

 

 

Pusat Pendidikan dan Pelatihan 
Badan Pusat Statistik 

Jakarta 



Pusat Pendidikan dan Pelatihan

Badan Pusat Statistik

Jalan Raya Jagakarsa No.70, Jakarta Selatan, 12620

www.pusdiklat.bps.go.id

pusdiklat@bps.go.id

(021) 7873781 - 83

(021) 7873955


	1: Cover Depan
	2: Cover Belakang

